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{Note: The English version of these instructions is available in the English primer template.
Ce gabarit accessible Word pour Windows facilite la création de documents d’introduction accessibles facilement et efficacement. Vous devez utiliser Word pour Windows pour pouvoir suivre toutes les étapes. Passez à Comment utiliser ce modèle}
{Titre}
{Indiquer le nom du secteur}
Sommaire
{Cette section devrait présenter un résumé concis du document d’introduction qui suit. Supposez que ce résumé servira à décrire et à présenter votre initiative dans d’autres documents liés à la transition.}
Introduction
{Cette section devrait présenter le document d’introduction et expliquer clairement l’importance du sujet pour la fonction publique et les Canadiens. Il devrait également résumer brièvement les répercussions pour le ministre.}
Renseignements généraux et contexte
{Remarque : on vous encourage à créer les sous-sections que vous jugerez nécessaires afin de transmettre les renseignements pertinents pour votre sujet de la façon la plus claire possible tout en veillant à écrire pour assurer une divulgation maximale des renseignements du gouvernement.
Dans cette section, définissez les termes et concepts clés pertinents. Décrivez le sujet et sa pertinence pour l’organisation et le ministre, et donnez tout autre renseignement dont le ministre ou son cabinet doivent être au courant. Les renseignements doivent être présentés de manière factuelle et non partisane, afin d’éviter une formulation et une présentation tendancieuse ou partisane. Le cas échéant, présentez dans cette section des données à l’appui des explications fournies.
Expliquez également le rôle de l’organisation ou du ministre dans le domaine. Une description du cadre législatif qui habilite ou touche le sujet devrait suivre.
Les renseignements sur les répercussions horizontales de l’initiative et les interdépendances entre l’organisation et d’autres ministères sur ce sujet doivent être présentés dans cette section. Discutez ensuite des mesures que le gouvernement a prises et identifiez les acteurs clés sur ce sujet. Si le sujet a des répercussions intersectorielles, veillez à consulter tous les secteurs impliqués.
S’il y a lieu, on peut inclure des renseignements détaillés ou précis dans une annexe.}
Conclusion
{Dans cette section, récapitulez brièvement les principaux points présentés dans le document d’introduction et précisez les principaux éléments à retenir pour le secteur.}
{Références
{Citez les documents mentionnés dans le document d’introduction; si vous n’avez pas de références, supprimez toute la section Références}
{par exemple : Myths of accessible typography, https://wcag2.com/accessible-typography-and-style/ (en anglais seulement)}
{par exemple : Répertoire des organisations et intérêts fédéraux, https://www.tbs-sct.gc.ca/ems-sgd/edb-bdd/index-fra.html#igoc/all}}
Bureau de première responsabilité
{Nom du sous-ministre adjoint}
{Nom du secteur ou du bureau}
{Numéro de téléphone}
Personne-ressource aux fins de suivi
Rédigé par : {indiquer le nom et le numéro de téléphone}
Directeur : {indiquer le nom et le numéro de téléphone}
Directeur exécutif : {indiquer le nom}
{Annexes
{énumérez les annexes ici, si vous n’en avez pas, supprimez toute la section Annexe}
{titre du document}
{Par exemple : Politique ministérielle-2019.pdf}}
[bookmark: _{How_to_use]{Comment utiliser ce gabarit et s’assurer que le document est accessible (Effacez les instructions avant la publication)
Contexte et conseils généraux
En vertu de la Loi révisée sur l’accès à l’information, les institutions gouvernementales doivent publier de façon proactive en ligne des renseignements essentiels, y compris des trousses d’information préparées à l’intention des nouveaux ministres et sous-ministres. Les documents d’information pour les nouveaux ministres doivent être affichés dans les 120 jours suivant leur nomination. Pour faciliter ce processus, rédigez le contenu selon les principes de transparence et d’« ouverture par défaut ».
La Loi canadienne sur l’accessibilité exige que les organisations sous réglementation fédérale, y compris le gouvernement du Canada, éliminent et évitent la création d’obstacles à l’accessibilité. Le processus éditorial lui-même doit être inclusif par défaut, afin que chacun puisse utiliser les documents et qu’ils puissent être facilement convertis en HTML aux fins d’affichage. Par conséquent, votre document doit être conforme aux normes d’accessibilité des documents et au Guide de style de Canada.ca (GSCC).
Amélioration continue : Le Bureau pour l’accessibilité dans la fonction publique du Secrétariat du Conseil du Trésor du Canada, et les concepteurs de modèles accessibles, David Berman Communications, s’engagent à améliorer continuellement la structure de ce modèle ainsi que ses directives. Certaines commandes peuvent varier selon la version de Word et la configuration de votre système. Si vous avez des questions ou des commentaires, veuillez envoyer un courriel au Bureau pour l’accessibilité dans la fonction publique par courriel à mailto:GC Accessibilité / Accessibilité GC <Accessibility.Accessibilite@tbs-sct.gc.ca> afin que tout le monde puisse bénéficier de vos suggestions.
Commencez toujours avec ce gabarit. Ce gabarit suit déjà la plupart des normes d’accessibilité et de style. Par conséquent, n’utilisez pas la commande « Nouveau document » dans Word. De plus, n’utilisez pas un document d’information existant et la commande « Enregistrer sous... » pour créer un nouveau document. En créant toujours vos documents Word à partir d’un gabarit .dotx qui intègre déjà les mesures d’accessibilité , vous évitez :
d’utiliser le format .doc plutôt que .docx (.doc n’est pas aussi accessible ni aussi vérifiable qu’accessible).
de modifier accidentellement le fichier « maître ».
En outre, vous :
utilisez automatiquement les bons titres, en-têtes et pieds de page aux fins d’accessibilité.
incluez automatiquement des paramètres optimaux pour la typographie, y compris l’espacement, le crénage, les ligatures et les puces conviviales.
profitez de nombreuses améliorations typographiques qui permettront à vous et vos collègues de gagner du temps lorsqu’il s’agira de convertir le fichier en d’autres formats.
Avant de commencer, tenez compte des principes de rédaction suivants :
Le document d’introduction ne se veut pas un examen exhaustif. il vise plutôt à permettre au lecteur de comprendre adéquatement le sujet afin de se préparer à des discussions à venir. Ce document d’introduction vise directement le ministre ou son cabinet. Lorsque vous rédigez :
Utilisez un langage clair et simple, en veillant à ce que les concepts soient faciles à comprendre et n’exigent pas d’avoir une connaissance préalable du sujet.
Veillez à ce que le document d’introduction n’aie pas plus de 10 pages (excluant les annexes). Il s’agit d’un maximum; souvent, une à deux pages suffisent.
Regroupez tous renseignements classifiés dans une section afin de faciliter le processus de caviardage avant la publication.
Si vous devez inclure des tableaux, suivez attentivement les directives ci-dessous.
N’utilisez pas d’images « décoratives ». Si vous devez inclure des images, choisissez des images fonctionnelles (Consultez le GSCC pour en savoir plus) :
· choisissez des images simples et significatives.
· assurez-vous que le contraste de couleurs des graphiques respecte le critère de réussite 1.4.3 du W3C WCAG 2 AA (utilisez l’analyseur de contraste de couleurs gratuit pour vérifier cela).
· Ajoutez toujours un texte de remplacement (voir les directives ci-dessous).
Traduisez le document d’introduction dans les deux langues officielles; assurez-vous de choisir le bon fichier de gabarit pour la langue principale; ne commencez pas par le fichier de modèle anglais pour créer la version française ou vice versa.
Utilisez un seul espace entre les phrases.
Lorsque le document a des annexes
Si votre document d’introduction fait référence à d’autres documents (c’est-à-dire des annexes ou pièces jointes, appelées simplement « annexes » dans la présente section), même s’ils sont fournis séparément, vous devez également veiller à ce que ces documents soient accessibles. Consultez les lignes directrices qui se trouvent sur la page GCpédia du Bureau pour l’accessibilité dans la fonction publique à l’adresse suivante : http://www.gcpedia.gc.ca/wiki/OPSA/BAFP:_Building_Accessibility_Confidence. Par exemple, si votre annexe est un document PDF et qu’un contenu équivalent est disponible dans une page Web accessible, vous pouvez suivre les directives suivantes s’il est impossible de rendre le document PDF accessible :
S’il est inévitable de publier une version inaccessible d’une annexe, vous devez :
Au tout début du contenu de l’annexe (c’est-à-dire, dans le fichier d’annexe proprement dit), ajouter un texte déclarant : « Ce document n’est pas entièrement conforme à toutes les directives applicables aux documents numériques accessibles : pour une version accessible », puis inclure l’une des mentions suivantes :
· « consultez : », puis ajoutez l’adresse URL complète (hyperlien) où l’utilisateur peut trouver la version accessible.
· « communiquez avec : » puis ajouter les coordonnées (« [nom] par courriel à [adresse de courriel] ou par téléphone au [numéro de téléphone] ») de la personne ou de l’agent que l’utilisateur peut contacter pour obtenir une version accessible.
S’il y a lieu pour le format de fichier de votre annexe, placez le même message dans un commentaire et dans les métadonnées (de préférence dans l’élément de métadonnées Objet); essentiellement, répétez ce message partout où l’utilisateur peut être en mesure de le lire, toujours au début du document ou aussi près du début que possible.
Ajoutez un avis d’inaccessibilité dans le nom de fichier de l’annexe : par exemple, « nomdefichier (accessibilité-limitée).extension ».
Dans la liste des annexes du document d’introduction, ajoutez un avis concernant tout fichier qui pourrait ne pas être accessible.
Lorsque vous copiez ou collez du contenu provenant d’une autre source
Mise en forme
Si vous copiez/collez du contenu d’une autre source dans ce document d’introduction, supprimez les éléments de format. Vous pouvez remettre le contenu en forme manuellement en appliquant les styles du document d’introduction (par exemple, gras ou italique). Voici des directives sur l’application des styles de mise en forme.
Listes
Si vous copiez/collez une liste, collez seulement le texte. Appliquez le bon style de liste à partir des styles du gabarit du document d’introduction; si vous remarquez des puces ou des chiffres « supplémentaires », supprimez ceux qui ont été collés en tant que caractères.
Polices, tailles de police et espacement
Ce gabarit a été testé pour l’accessibilité visuelle ainsi que pour l’accessibilité technique et est conforme au GSCC. Les polices et les tailles de police, ainsi que l’espacement entre les lettres, les mots, les paragraphes, et les colonnes, entre autres, sont testées et approuvées.
N’utilisez jamais des retours de paragraphe consécutifs ou plusieurs onglets pour créer des espaces verticaux ou horizontaux supplémentaires.
Étapes pour créer le document d’introduction Word
1. Ouvrez la version anglaise ou française du gabarit .dotx du document d’introduction (.dotx est le format de gabarit Word) à l’aide de Microsoft Word 2013, 2016, 2019 ou 365 (modèle anglais pour la création de documents en anglais, modèle français pour les documents en français). Cela créera un nouveau document vide dans Word. N’utilisez jamais la commande « Nouveau document » et n’utilisez jamais « Enregistrer sous » à partir d’un document d’introduction existant.
Recherchez dans votre document les accolades (« crochets bouclés » {}) et remplacez le texte entre les accolades par le texte approprié. Supprimez ensuite les accolades.
· Parfois, le texte entre les accolades indique un espace réservé (comme pour le titre), et parfois il décrit le contenu à inclure dans cette section (comme le Sommaire).
· Exemple : Au sujet de la classification du document, chaque document est protégé B à moins qu’il ne contienne des renseignements secrets. Par conséquent, dans l’en-tête de votre document, à l’intérieur des accolades, supprimez tout sauf un des énoncés « Protégé B », « Secret », ou « Non classifié » puis supprimez les barres verticales et les accolades.
Pied de page
· Ne modifiez pas le pied de page du document d’introduction . Il contient la numérotation automatique et présente automatiquement le titre de votre document de façon accessible.
En-têtes
· N’appliquez jamais le style « Heading 1 » (« Titre 1 ») à un contenu quelconque (le titre du document d’introduction utilise déjà le style « Heading 1 » (« Titre 1 ») et doit être le seul style « Heading 1 » (« Titre 1 ») dans le document).
· Les sections principales du document d’introduction commencent par un texte intitulé « Heading 2 » (« Titre 2 »). Par conséquent, si vous souhaitez créer une sous‑section dans une section, utilisez le style « Heading 3 » (« Titre 3 ») (Accueil> Styles> Heading 3 [Titre 3]) pour créer un titre qui indique le sujet ou l’objet de la sous-section. Si vous avez besoin de sous sous-sections, utilisez le style « Heading 4 » (« Titre 4 ») et continuez jusqu’à « Heading 6 » (« Titre 6 ») au besoin.
· Ne sautez pas les niveaux de titre (par exemple, n’ajoutez pas un « Heading 4 » (« Titre 4 ») s’il n’y a pas de « Heading 3 » (« Titre 3 ») précédent). Vous pouvez afficher votre plan de document en cochant la case « Affichage> Volet de navigation ». Votre volet de navigation affichera vos titres imbriqués par niveau : vous verrez qu’il ressemblera automatiquement à une table des matières pour votre document d’introduction sans titre « en double retrait ».
· N’utilisez que des titres pour aider les personnes à naviguer, jamais pour l’esthétique : utilisez-les seulement pour le libellé qui décrit le contenu qui suit.
· Pratique exemplaire : Gardez les titres à 60 caractères ou moins, 80 au maximum, et évitez d’avoir les mêmes mots au début de tous vos titres (par exemple, « L’importance d’utiliser des titres », « L’importance d’utiliser des styles », « L’importance d’utiliser des listes correctement formatées »).
Texte du corps : sélectionnez toujours le style « Normal » dans « Accueil> Styles ».
Lorsqu’on met l’accent sur les mots :
· Souligné : utilisez uniquement pour les liens; soulignez toujours les liens et ne soulignez jamais quoi que ce soit qui n’est pas un lien.
· Gras : Utilisez-le avec parcimonie, pour mettre l’accent sur les mots dans une phrase. Sélectionnez le texte à mettre en gras et sélectionnez « Accueil> Styles> Bold » (« Accueil> Styles> Gras »).
· Italique : Ne l’utilisez que selon les conventions du GSCC (par exemple, les titres de livre), et non pas pour mettre l’accent. Sélectionnez le texte que vous souhaitez mettre en italique et sélectionnez « Accueil> Styles> Italic » (« Accueil> Styles> Italique »).
Listes
· Pour les listes numérotées (ordonnées), sélectionnez le texte puis appliquez le style « Numbered List » (« Liste numérotée »). Pour les listes à puces (non ordonnées), sélectionnez le texte, puis appliquez le style « Bulleted List » (« Liste à puces »). Conseil : Vous pouvez utiliser les commandes Word « Accueil> Paragraphe> Augmenter/Réduire le retrait » (ou utiliser les raccourcis clavier Tab et Maj+Tab) pour modifier les niveaux de liste imbriqués.
Majuscules, exposants, indices
· N’écrivez pas tout en majuscules afin de mettre l’accent sur le texte. Dans les cas où le GSCC exige tout en majuscules (par exemple, pour des désignations comme « MD »), tapez votre texte dans la case appropriée, puis appliquez le style « All Caps » (« Tout en majuscules ») pour le mettre en « majuscules ». Si les caractères en majuscules sont plus grands que nécessaire (comme dans le cas des désignations), utilisez le style « Designations » (« Désignations ») qui a une taille de police légèrement plus petite. Pour les petites majuscules (c’est‑à‑dire, tout le texte apparaît en majuscules, avec les minuscules apparaissant sous forme de petites majuscules), encore une fois tapez le texte en majuscules, puis sélectionnez le style « Small Caps » (« Petites majuscules »).
· Utilisez l’exposant et l’indice correctement au besoin (par exemple, 1er, H2O). (N’utilisez pas d’exposant ni d’indice pour le style visuel uniquement). Sélectionnez le texte auquel vous souhaitez appliquer l’exposant ou l’indice, puis choisissez le style « Superscript » (« Exposant ») ou « Subscript » (« Indice »).
Guillemets et apostrophes
· Utilisez de véritables guillemets d’ouverture et de fermeture (aussi appelés « guillemets intelligents » ou « guillemets typographiques ») et des apostrophes : jamais des signes de pouce et de pied (aussi appelées « guillemets droits »), ni de marques prime ou double prime.
· Pour configurer le correcteur automatique de Word de façon à ce que les guillemets droits soient automatiquement remplacés par des guillemets appropriés, sélectionnez : Fichier> Options> Vérification> Options de correction automatique... puis, dans les onglets « Mise en forme automatique ») et « Mise en forme automatique au cours de la frappe », cochez la case « Remplacer les guillemets dactylographiques par des guillemets typographiques ».
Liens
· Assurez-vous que le texte visible de votre lien est significatif (par exemple, « visitez notre site Web » plutôt que « cliquez ici » ou juste l’adresse hyperliée (c’est-à-dire, « adresse URL »).
· Sélectionnez le texte qui deviendra un lien , puis tapez Ctrl+K pour afficher la boîte de dialogue « Insérer un hyperlien », le curseur apparaîtra dans le champ approprié. Tapez ensuite l’adresse URL et sélectionnez OK.
· Conseil : si vous savez que le fichier Word sera converti en format PDF, et qu’il est important pour vous d’éviter les fausses erreurs dans PAC Accessibility Checker : dans la boîte de dialogue « Insérer un hyperlien », dans le champ « Info-bulle », recopiez le texte affiché.
· Lorsque vous insérez un lien, il devrait apparaître automatiquement comme un Hyperlien; dans le cas contraire, sélectionnez le texte du lien et appliquez le style « Hyperlink » (« Hyperlien »).
Tableaux : Évitez d’inclure des tableaux dans les documents d’introduction (il ne s’agit pas d’une directive sur l’accessibilité, mais d’une directive stratégique). Si un tableau est nécessaire :
a) Utilisez la commande « Insérer> Tableau> » (jamais la commande « Dessiner un tableau ») :
b) Lorsque vous insérez un tableau, évitez les lignes à plusieurs en-têtes et les cellules fusionnées car il est impossible de les rendre accessibles dans Word. il faut plutôt les rendre accessibles manuellement une fois que le fichier sera converti en format HTML ou PDF.
c) En plaçant le curseur n’importe où dans le tableau, sélectionnez Conception de tableau> Styles de tableau> Style de tableau.
d) Sélectionnez toute la ligne d’en-tête, puis cochez la case « Conception de tableau> Options de style de tableau> Ligne d’en-tête ». (Office 2016 ou version antérieure : « Outils de tableau> Conception> cochez la case Ligne d’en-tête »).
e) Avec toute la ligne d’en-tête toujours sélectionnée, assurez-vous de sélectionner « Disposition> Répéter les lignes d’en-tête ». Remarque : Lorsque le curseur se trouve dans un tableau, il peut y avoir deux menus de disposition dans le ruban; pour vous assurer de sélectionner le menu « Disposition » qui s’applique aux tableaux de cette étape, vérifiez que le curseur se trouve dans une cellule d’en-tête de tableau, puis sélectionnez les touches suivantes l’une après l’autre : Alt, J, L.
f) Avec toute la ligne d’en-tête toujours sélectionnée, appliquez le style « Accueil> Styles> Table Headers » (« Accueil> Styles> En-têtes de tableau »).
g) Sélectionnez toutes les lignes du tableau et sélectionnez « Accueil> Styles> Table Text » (« Accueil> Styles> Texte de tableau »).
h) Placez le curseur n’importe où dans le tableau, sélectionnez la commande Références> Insérer une légende pour ajouter une légende visible ou un « titre » au-dessus du tableau :
i) Sélectionnez « Tableau » dans le menu déroulant « Étiquette » qui énumère « Figure », « Équation » ou « Tableau ».
ii) Dans le champ « Légende », ajoutez le tableau x numéroté avec le titre du tableau; ce qui donne, par exemple, « Tableau 5 : Taux de chômage par province ».
iii) Établissez la position à « Au-dessus de la sélection ».
i) Ne mettez pas de texte de titre avant un tableau. Au lieu d’avoir un titre « Taux de chômage par province » suivi de « Tableau 1 », laissez la légende faire tout le travail : « Tableau 1 : Taux de chômage par province ».
j) Assurez-vous que le style utilisé pour la légende est « Caption » (« Légende »). Autrement, sélectionnez la légende et sélectionnez le style « Caption » (« Légende ») dans le volet « Styles ».
k) Lorsque vous modifierez la légende plus tard, il vous suffira de modifier le texte du document (ne suivez pas les étapes pour appliquer une légende, car cela appliquera une deuxième légende).
Graphiques et images (appelés « figures ») : Évitez d’inclure des figures dans les documents d’introduction (il ne s’agit pas d’une directive sur l’accessibilité). Si une figure est nécessaire, veuillez suivre les étapes suivantes :
l) Créez un paragraphe vide afin d’y placer la figure et placez le curseur dans ce paragraphe, puis sélectionnez le style « Image ».
m) Utilisez uniquement la commande « Insertion> Images » Parce qu’une figure externe est le seul type que l’on puisse insérer d’une manière entièrement accessible.
n) Sélectionnez la figure, puis sélectionnez la commande « Références> Insérer une légende » pour ajouter une légende visible au-dessus de la figure. La légende visible doit être un résumé des renseignements importants de la figure. Définissez les propriétés suivantes dans la boîte de dialogue :
i) Sélectionnez « Figure » dans le menu déroulant « Étiquette » qui énumère « Figure », « Équation » ou « Tableau ».
ii) Dans le champ « Légende », ajoutez la figure x numérotée automatiquement avec le nom de la figure, ce qui donne, par exemple, « Figure 5 : Chiens ».
iii) Établissez la position à « Au-dessus de la sélection ».
o) Ne mettez pas de titre sur une figure. Au lieu d’avoir un titre « Chiens » suivi de « Figure 1 », laissez la légende faire tout le travail : « Figure 1 : Chiens ».
p) Assurez-vous que le style utilisé pour la légende est « Caption » (« Légende »). Autrement, sélectionnez la légende et sélectionnez le style « Caption » (« Légende ») dans le volet « Styles ».
q) Lorsque vous modifierez la légende plus tard, il suffira de modifier le texte du document. Ne suivez pas les étapes pour appliquer une légende, car cela appliquera une deuxième légende.
r) Sélectionnez la figure, puis sélectionnez Format de l’image> Disposition et propriétés> Texte de remplacement> champ Description (Office 365 : « Format de l’image> Texte de remplacement ») et entrez une description plus détaillée de la figure que la légende. Incluez tous les renseignements importants qui se trouvent dans la figure dans le texte de remplacement. (Office 365 : Ne cochez pas la case « Marquer comme décoratif »).
s) Sélectionnez la figure, puis sélectionnez Disposition> Habillage du texte> Aligné sur le texte (Office 365 : « Format de l’image> Position> Aligné sur le texte »).
Dernières étapes avant la publication
1. Sélectionnez tout le texte (Ctrl+A), puis sélectionnez « Révision> Langue> Définir la langue de vérification », puis sélectionnez la langue principale du gabarit. Si le texte contenu dans le document est dans une langue différente de la langue principale, sélectionnez-le séparément et utilisez la même technique pour identifier la langue appropriée à chaque sélection.
Recherchez dans le document toutes les accolades d’ouverture et de fermeture ({}) pour vous assurer que le texte de l’espace réservé et les directives ont été remplacés ou supprimés.
Pour afficher le plan de votre document, cochez la case Affichage> Volet de navigation et sélectionnez « Titres » dans le volet (plutôt que « Pages » ou « Résultats »). Le volet de navigation affichera les titres par niveau. Assurez-vous qu’il ressemble à une table des matières du document d’introduction sans titre « en double retrait ». Si vous avez « ignoré » un niveau de titre à n’importe quelle étape, appliquez les styles de titre appropriés jusqu’à ce qu’ils soient corrigés.
Éliminez les espaces blancs inutiles : recherchez et remplacez toutes les combinaisons suivantes (répétez chaque combinaison plusieurs fois, même une fois que vous avez atteint la fin du document, jusqu’à ce qu’il ne reste aucun cas de chaque combinaison) :
a) marqueurs de paragraphe double (^p^p) pour les marqueurs de paragraphe simple (^p).
b) marqueurs de tabulation double (^t^t) pour les marqueurs de tabulation simple (^t).
c) espaces doubles pour espaces simples (même après les phrases).
d) espace suivi du marqueur de paragraphe ( ^p) pour le marqueur de paragraphe uniquement ( ^p).
e) espace suivi du marqueur de tabulation ( ^t) pour le marqueur de tabulation ( ^t).
Cherchez l’italique pour mettre l’accent et remplacez-le par du gras :
f) Ouvrez la boîte de dialogue « Remplacer ».
g) Cliquez sur le bouton « Plus ».
h) Placez le curseur dans le champ « Rechercher : », sélectionnez Format> Police... puis, dans le style « Police », sélectionnez « Italique », puis cliquez sur OK.
i) Utilisez la commande « Suivant » pour rechercher tous les cas où vous avez utilisé l’italique pour mettre l’accent et modifiez-les manuellement en gras en appliquant le style « Bold » (« Gras »).
Recherchez les guillemets droits et ceux qui devraient être des guillemets d’ouverture et de fermeture. Recherchez des marques de pouce qui devraient être des apostrophes.
Testez l’orthographe, la grammaire et le niveau de lecture (conformément aux normes du GSCC).
j) Pour l’anglais :
i) Si le texte que vous testez contient des listes, ajoutez un point à la fin de chaque élément (de sorte que l’outil teste correctement ce texte).
ii) Sélectionnez Fichier> Options> Vérification.
iii) Sous « Lorsque vous corrigez l’orthographe et la grammaire dans Word », cochez toutes les cases vides.
iv) Sélectionnez le bouton OK.
v) Sélectionnez le texte à tester (par exemple, tout le document).
vi) Sélectionnez « Révision> Orthographe et grammaire » (Office 365 : Révision> Vérifier le document).
vii) Si Word signale des problèmes, réglez-les.
viii) Une fois qu’il n’y a aucun problème, la boîte de dialogue « Statistiques de lisibilité » s’affiche, y compris le Niveau de qualité Flesch-Kincaid.
ix) Supprimez les points que vous avez ajoutés à la première étape.
k) Pour le français, utilisez Scolarius.com (http://www.scolarius.com) conformément au GSCC.
Sélectionnez Fichier> Info> Vérifier l’absence de problèmes> Vérifier l’accessibilité. Si vous avez suivi les étapes ci-dessus, il ne devrait pas y avoir d’erreurs. Si des erreurs apparaissent, suivez les directives du volet de vérification de l’accessibilité de Word ou consultez les étapes ci-dessus.
Supprimez toutes ces directives, ainsi que le premier paragraphe d’instruction du document; vous avez fini!
[Version beta 1.0 du modèle pilote en anglais, le 17 octobre 2019. Document original de David Berman Communications de 2011-2019 protégé par le droit d’auteur, utilisé sous licence limitée.]}
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